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Introduzione

Scopo di questo manuale e fornire una procedura per la gestione delle licenze in un
flusso di lavoro Prinergy.

Questa manuale fa riferimento a Prinergy 3.x
Questo manuale presuppone che siate gia’ in possesso delle nuove licenze da utilizzare

in Prinergy. Nel caso in cui non disponiate di tali licenze, contattare il servizio di
assistenza tecnica via telefono o tramite il portale web (http://ecentral.creo.com).
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2.

2.1

Arresto del sistema Prinergy

La gestione delle licenze in un flusso di lavoro Prinergy, e’ possibile solo quando il flusso

di lavoro e’ fermo. Per fermare il flusso di lavoro, recarsi davanti al server primario e
dal “Prinergy Administrator” eseguire il comando di “File -> Stop”.

¥CS1608-367 - Administrator

File View JITP Tools License Help

Connect to Server... Ctrl+0O

Start ..,

Preferences ... :

1 ¥C51608-367

Exit

el l Status

Running

Running
unhing

Ruri

2.2

servers” e confermare con “Stop”.

9z22| Stop systemon:

" Selected Server

..........................

Reason for Shutdown:

Stop

' Cancel

Note: This information will be logged in the Windows event log

Nel caso in cui disponiate di un flusso di lavoro formato da piu’ stazioni, selezionare “All

X

2.3
“Stopped”.

¥(S1608-367 - Administrator

File WYew JTP Tools License Help

l Update Level | Status

Server Name

[SivCs1608367 1 31.03
5 YCS1603367  3.1.0.3
5 vCS785367  3.1.0.3
§ vCs7ee-367  31.0.3

Stopped
Stopped
Stopped
Stopped

Attendere l'arresto del sistema, fino a quando ogni stazione risulti essere in stato di
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3. BackUp delle licenze in uso

3.1 Ora possiamo gestire le licenze con I'apposito menu’ “Licese -> Manage License Key...”

¥(S1608-367 - Administrator

File View JTP Tools | License Help

Manage License Key...

Server Name I Update Lev Status I
= 367 31.03

Ej YCS1609-367 31.03
Lf__l YCS785-367 31.03

B vCs78s-367 3.1.03

3.2 A titolo cautelativo, eseguire una copia di riserva delle licenze attualmente in uso nel
sistema Prinergy, premendo il tasto “"Save To File”.

License Information B X|

Dongle Security Code:
| 00420 - cc - e7f08b - abbc39 - 4783af - addcac - 1f48e3

License Keys l Expiry Date

All Currently Licensed Features

dBe3dEa9 - 273c8cda - aBdEd37e - 58f3f1 fc - f7ddbebe - 0f5a50d8 - Bebd...  Never

aBdEd37e - 58f3f fc - f7ddbebc - 0f5a50d8 - f7d4bebc - 0f5a50d8 - Bebd...  Expired

f7ddbebc - 273c8cda - aBdEd37e - 5Bf3f1fc - f7d4bebe - 0f5a50d8 - Bebd...  Evaluation (10-01-2006)

Option I Instances | Expiry Date -
Base System 1 Never

Refine 1 Never

Output Loose Proof 1 Never s
Output Imposed Proof 1 MNever

Qutput Final 1 Never

Import/Export 1 Never
Archive/Retrieve/Purge 1 Never

Page Handling 1 Never

Imposition Proofing & Output Final 1 Never

Imposition Management 1 MNever

Archiving 1 Never

Job Context 1 Never

PS Flat Handling 1 Never

Auto Page Assignment 1 Never

Hot Folders 1 Never

Workflow Toolbar 1

Concurrent Users
Digital Double Burn
Reaqional Versioning
Interactive Imnnsitinhinn

Enter License Key Remove License Key Save To File |
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3.3 Selezionare un nome del file ed un percorso di destinazione a vostra discrezione.
Savein: |-y CREO_DO_NOT_DELETE ~| e ®ckE-

#] licenza al 15-11-2006.key

My Network P...

File hame: IIicenza al 10-01-2007 j | Save I
Save as type: |Licensing Key File [* key) ~| Cancel I

Queste licenza potra’ essere ripristinata, in un secondo momento, nel caso in cui
qualcosa non dovesse funzionare correttamente con le nuove licenze.

Il file cosi’ generato sara’ un documento di testo contenente tutte le licenze attualmente
presenti nel sistema Prinergy.

Ricordatevi di memorizzare con cura il percorso nel quale avete salvato questo file!

Questa operazione puo’ essere ripetuta tutte le volte che lo riteniate necessario.
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4.

4.1

Rimozione licenze non necessarie

Nella finestra “License Information”, guardando la colonna “Expiry Date”, possiamo
trovare 3 tipi di licenze, classificate con il seguente stato:

Never:
una chiave con una data di scadenza Never, €’ la chiave principale del sistema.
In questa licenza sono racchiuse tutte le funzionalita’” acquistate in fase d’ordine,
queste funzionalita’ non scadranno mai e funzioneranno correttamente per
sempre.

Evaluation:
una chiave con data di scadenza Evaluation, €’ una chiave di prova che e’ stata
attivata per un tempo limitato. Durante questo tempo avete la possibilita’ di
provare tutte le funzionalita’ qui elencate, per accertarne la loro reale utilita’.
Queste funzioni scadranno al sopraggiungere della data indicata. Le licenze
Evaluation possono essere richiesta al venditore od al reparto di supporto, per
ogni funzione presente nel flusso di lavoro Prinergy.

Expired:
una chiave con data di scadenza Expired, e’ una chiave Evaluation che ha
terminato il suo ciclo di vita. Questa chiave non e’ piu’ utilizzabile e non apporta
nessuna funzione al flusso di lavoro Prinergy, possiamo quindi eliminarla senza
problemi.

License Information 3 X|

Dongle Security Code:
| 00420 - cc - e7f08b - aBbc39 - 4783af - addcac - 1f48e3
License Keys I Expiry Date

All Currently Licensed Features
dBe3dEa9 - 273c8cda - aBdEd37e - 58f3f1 fc - f7ddbebc - 0f5a50d8 - Bebd...  Never
a8dEd37e - 58f3f1fc - f7ddbebc - 0f5a50d8 - f7ddbebc - 0f5a50d8 - Bebd...

f7d4bebc - 273c8cda - a8dEd37e - 58f3f1fc - f7d4bebc - 0f5a504d8 -

Expired
Evaluation (10-01-2006)

Option I Instances | Expiry D ate -
Base System 1 Never
Refine 1 Never
Output Loose Proof 1 Never b
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4.2 Selezionando con il mouse una licenza Evaluation, nella finestra “License Information”,
verranno visualizzate le opzioni legate a quella singola licenza, e la data di validita’ della

stessa.

License Information E x|

Dongle Security Code:
| 00420 - cc - e7f08b - a6bc39 - 4783af - addcac - 1f48e3

License Keys I Expiry Date I

All Currently Licensed Features
d8e3dEal - 273c8cda - aBdEd37e - 58f3f1fc - 7ddbebe - 0f5a50d8 - Bebd...  Never
a8d6d37e - 58f3f1fc - f7d4bebe - 0f5a50d8 - f7d4bebe - 0f5a50d8 - 6e5d...  Expired

l Instancesl Expiry Date -

Option
1 10-01-2007

Regional Versioning

k- |

Enter License Key Remove License Key Save To File I
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4.3 Selezionando con il mouse una licenza Expired, nella finestra “License Information”,

verranno visualizzate le opzioni legate a quella singola licenza, e la data in cui tale
licenza e’ scaduta.

x
Dongle Security Code:
| 00420 - cc - e7f08b - aBbc39 - 4783af - addcac - 1f48e3
License Keys l Expiry Date |
All Currently Licensed Features
d3e3d6al - 273cBcda - a8d6d37e - 58f3f1fc - [7d4bebe - 0f5a50d8 - Bebd...  Never
Expired
f7dd4bebc - 273c8cda - aBdBd37e - 58f3f1fc - (7d@Bebe - 0f5a50d8 - 6e5d...  Evaluation {10-01-2006)
Option l Instances | Expiry Date -
Regional Versioning 1 10-12-2006
hd

Enter License Key Remove License Key Save To File |

4.4 Per eliminare una licenza scaduta, selezionare la licenza da rimuovere, accertarsi che

tale licenza sia scaduta e, successivamente, premere il pulsante "Remove License Key”,
confermare poi con con “Ok”.

4.5 Ripetere il punto 4.4 fino alla rimozione di tutte le licenze temporanee scadute.
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5.

5.1

5.2

Inserimento nuove licenze

Prima di poter inserire una nuova licenza in Prinergy, dobbiamo salvare la licenza
(solitamente ricevuta via mail), in un file di testo. Per eseguire questa operazione basta
aprire la mail ricevuta, e salvarla in formato .TXT (solo testo) dal programma di posta.

Nell’esempio riportato qui sotto il file e’ stato chiamato “nuova licenza.txt” ed e’ stato

salvato sulla

scrivania.

21 x|

Save in: I@ Desktop _'J @~ Q X [y i3~ Tools~
: My Documents
(5 ¢ My Computer
MyRecent  [W.JMy Network Places
Documents ) Da_sistemare
73 ) Insite Servers
Desktop

My Documents

ey

-
- ]
i
My Computer

y
My Network
Places

File name:

Save as type:

|nuova licenza. txt

=l

IText Only (*.txt)

E

| Save I
Cancel I
]

4

Via rete, copiate questo file sul server primario del flusso di lavoro Prinergy. Per
comodita’ potete usare la directory dei lavori J:\Jobs sul disco dei lavori (Disco data).
Questa cartella e’ condivisa sia per PC che per Mac, e’ la cartella che utilizzate
giornalmente per la creazione e la gestione dei lavori su Prinergy.
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5.3 Recatevi davanti al server primario Prinergy ed aprite il file .TXT creato al punto 5.1
(oppure un file di backup nel caso in cui stiate facendo un ripristino) utilizzando
I'applicazione “Notepad”, questa si aprira’ in automatico con un doppioclick sul file, se
avete utilizzato un estensione .TXT. Nel caso in cui non abbiate dato nessuna
estensione al file di testo (chiamandolo ad esempio “nuova licenza” omettendo
I'estensione “.txt", oppure se stiamo utilizzando un file di backup con estensione “.key”)
il sistema Windows, vi chiedera’ con quale programma aprire il file di testo, scorrete
nell’elenco dei programmi fino a selezionare “Notepad”; confermate con “OK".

£ Click the program you want to use to open
b E 'systemz2.txt_",
If the program is not listed, click Other.

Description For files of this type:

Choose the program you want to use:

E]Imaging ;I
@,Imaging Preview
& Internet Explorer
P Microsoft Network Monitor
?%’Microsoft Pain
@Notepad

™ pcanywhere Host
L7 . ' n_:__m

KN

v

I @lways use this program to open these Files:
| oK I Cancel | Other... |

5.4 Una volta aperto il file, evidenziare col mouse la serie di lettere e numeri che troverete
dopo “License Key:”, ed effettuare un “"CTRL-C” (oppure “Edit -> Copy”) di questa parte

del testo.

_loix
File Edit Format View Help

From: noreply@creo.com =]

sent: lunedi 22 gennaio 2007 11.00

To: Evaluation Key

Cc: Mauro Lussignoli

subject: Evaluation Key: 01713 - d2 - c5af46 - 7b2022 - 4a95ae - 65872a - 76al97, CEU, SERVICES, 634
-00312A : Preps Plus FLIM 1-Pack EP

evaluation License Key Generated

The following temporary Evaluation key was generated:

Product: Prinergy 3.0.3.1

License option: 634-00312A : Preps Plus FLIM 1-Pack EP

submitted by: CSE\MLuSS1gn

Customer name: Alfagi

Region: CEU

Group: SERVICES

pongle ID: 01713 - d2 - c5af46 - 7b2022 - 4a95ae - 65872a - 76al97
Key expires on: wednesday, March 28, 2007

02dfb K []
"chd’Ab - 378291 a8 - c5e6210f - 4c871735 -
48belc87 - bifd327e - 2f6bcede - 7e198220 -

82de 8
d2 1’86007’ - 3067f302 =
a03bafb2 - 40da9bc3 - 9d546ce3 - 028ef514 - 624b595F -
d5168bb8 - cd89ad3d - 4527d70e - d3867364_— ce9a8cd0 -

[ <]

questa serie di lettere e numeri, andra’ copiata nella finestra “License Information”.
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5.5 Tornare alla finestra “License Information” e premere il pulsante “Enter License Key”.

License Information 3 ' l[

Dongle Security Code:
I 00420 - cc - e7f08b - abbc39 - 4783af - addcac - 1f48e3
License Keys l Ex=piry Date l
All Currently Licensed Features
d8e3d6al - 273c8cda - a8d6d37e - 5Bf3f1fc - f7d4bebc - 0f5a50d8 - Bebd...  Never
aBdEd37e - 58f3f1fc - f7d4bebc - 0f5a50d8 - f7d4bebce - 0f5a50d8 - Bebd...  Expired
f7ddbeSc - 273cBcda - aBdEd37e - 58f3f1fc - f7ddbebe - 0f5a50d8 - Bebd...  Evaluation {10-01-2006)
Option I Instances l Expiry Date -
Base System 1 Never
Refine 1 MNever
Output Loose Proof 1 Never e
Output Imposed Proof 1 Never
Output Final 1 Never
Import/Export 1 Never
Archive/Retrieve/Purge 1 Never
Page Handling 1 Never
Imposition Proofing & Output Final 1 Never
Imposition Management 1 Never
Archiving 1 MNever
Job Context 1 Never
PS Flat Handling 1 Never
Auto Page Assignment 1 Never
Hot Folders 1 MNever
Workflow Toolbar 1 Never
Concurrent Users 6 MNever
Digital Double Burn 1 Never
Reaional Yersioning 1 Never
Interartive Imnnsitinninn 1 Never .v_J
Enter License Key Remove License Key Save To File I

5.6 Posizionarsi col mouse nella riga “"New License Key” della finestra di dialogo ed
effettuare un “CTRL-V”

Enter License Key E X|

Dongle Security Code:
| 00420 - cc - e7f08b - abbc39 - 4783af - addcac - 1f48e3

New License Key:
|b421 5 - f3e94fbb - BceeZefe - 6648de34 - 859befIa - 071c50ca - 727d9c8b - 542f3d0d - abecedel - a0

Browse...

Load Key From File:

|
ReadFile... l

Cancel

confermare con “Apply”. Chiudere la finestra “License Information” con “OK".
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6. Riavvio del sistema Prinergy

6.1 Per verificare il corretto funzionamento delle nuove licenze, avviare il flusso di lavoro
Prinergy, con il comando “File -> Start”.

Y(S1608-367 - Administrator

File Yew JTP Tools License Help
Connect to Server... Ctrl+O

F
2 el l Status l
Stop ... Stopped
Preferences ... Stopped
Stopped
1 ¥CS1608-367 Stopped

Exit

6.2 Aspettare che tutte le stazioni siano in stato di "Running”.

YCS1608-367 - Administrator

File VYiew JTP Tools License Help

Processes I JTPs |

Server Name I Update Level I Status I —
|=JiYCS1608-367 i 3103 Running |_Application

5 YCS1609367  3.1.03 Running & tichive Daemon (
= yCs785-367  3.1.03 Running i Archive Daemon |
5 YCS786-367 31.03 Running & Archive Daemon (

% Archive Daemon [
3 Archive/Retrieve .
8 Automnation Daer
% Automation Web ¢
ﬁ CEPS Conversion
& Client Manager Dz
¥ Creo Color Matche

6.3 La verifica delle nuove funzionalita’ relative alla nuova licenza, varia da caso a caso, in
relazione alle funzioni che la nuova licenza ha attivato nel flusso di lavoro.
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7. Ripristino licenza di BackUp

7.1 Nel caso in cui qualcosa non dovesse funzionare correttamente, possiamo sempre
ripristinare la licenza di BackUp.

7.2 Per fare cio’, ripetere i passaggi da 5.3 a 5.6 utilizzando il file salvato al punto 3.2.

Fine.
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